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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before connecting the
probe to the circuit under test. Connect the probe reference lead to the circuit under test before connecting the probe
input. Disconnect the probe input and the probe reference lead from the circuit under test before disconnecting the probe
from the measurement instrument.

Ground the Product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.
Provide Proper Ventilation. Refer to the manual’s installation instructions for details on installing the product so it has
proper ventilation.
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General Safety Summary

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:
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Preface

Preface
This manual contains supplemental user information for the following instruments:

WFM6120

WFM7020

WFM7120

WFM6100 with Option MB

WFM7000 with Option MB

WFM7100 with Option MB

Where to Find More Information
Item Purpose Location
Quick Start User Manual Installation and

high-level overview
of instrument operation

Online Help In-depth instrument
operation and UI help

Specifications and
Performance Verification

Specifications and
procedure for checking
instrument performance

WFM, WVR, and AMM
Series Management
Information Base (MIB)

SNMP command
reference for remotely
controlling the instrument

Service Manual Optional manual
supporting module-level
servicing of the
instrument

Conventions Used in this Manual
The following icons are used throughout this manual:

Sequence Step Connect power Network XGA
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Incoming Inspection

Incoming Inspection
The incoming inspection procedures are optional procedures that check the functionality of the instrument and require
no equipment other than a display. For a more robust inspection, see the performance verification procedures in the
WFM6120, WFM7020, and WFM7120 Specifications and Performance Verification manual that is included on the Product
Documentation CD that was shipped with your instrument.

Basic Turn On and Self Test

1. Connect an XGA monitor to the EXT
DISPLAY connector on the rear of the
waveform monitor.

2. Connect the AC line cord to the rear of
the instrument and to a 100 to 240 VAC
source. There is no power switch on the
waveform monitor, so the instrument will
turn on as soon as you apply power.

3. Look at the front panel immediately after
you apply power. The MAG, LINE SEL,
and CURSOR buttons should be lit.
The other front-panel buttons will light
one at a time, in sequence. Verify that
all buttons do light. The sequence will
repeat until the Boot Loader process
completes (approximately 30 seconds).

4. Verify that the instrument passes all self
tests. Any failures will be shown in Red.
The results of the Power On diagnostics
are erased from the screen, but you
can view them by selecting CONFIG
> Utilities > View Diagnostics Log >
SEL.

5. After the diagnostics are finished, the
instrument state will be restored. When
the progress indicator in the lower-right
part of the screen is finished, the
instrument has finished initializing. If it is
still open, exit the Diagnostics Log.

Waveform Monitors Technical Reference 1



Incoming Inspection

Front Panel Test

1. Press and hold the PRESET button.

2. Select Recall Preset > Recall Factory
Preset and the press the SEL button.

3. Press FULL to make the active tile be
full screen.

4. Press HELP to display the help screen.

5. Press all the other buttons.
Each button should flash as you press
it. Most buttons bring up related help
text. Some buttons, such as the presets,
bring up the same information. The
HELP button, the four arrow keys, and
the SEL button do not bring up help text
because they traverse the help panes
and content.

6. Press the right arrow key until the Help
Contents pane in the upper-left corner is
highlighted.

7. Turn the GENERAL knob and verify that
the selector box moves up and down the
list.

8. Press HELP to exit help.

Fan Test
You should be able to hear the fans and feel air coming out the back of the instrument. At low temperatures the fans
will turn slowly and be very quiet.
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Installation Variations

Installation Variations
See the Quick Start User Manual that was shipped with your instrument for basic installation instructions. Read the following
information for other installation situations and for remote communication instructions, an optional procedure that is suitable
for incoming inspection of this product.

Connecting Directly to a PC
The following procedure will help you connect your instrument to a PC:

1. Connect the instrument to a PC through
an ethernet hub, as shown. A standard
crossover cable can be substituted for
the hub.

2. Set up the instrument as described in
the following procedures (See page 4,
Connecting to a Network.), choosing
Manual IP mode to set the IP address
manually. Be sure to set an address that
is compatible with the setting of your PC.

3. If you are using an SNMP setup, use the
SNMP setup procedure.
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Connecting to a Network
The following topics cover configuring the IP settings, so that you can use your instrument over a network, and configuring
SNMP, which is required if you are using commands to control the instrument.

Connection and IP Settings
To allow network access to the instrument, you need to set the IP address. Network addresses can be assigned either
automatically or manually. If your network does not use DHCP, you will have to manually enter the address for the instrument.
To get an address, talk to your LAN administrator.

To connect your instrument to a network and
access it with a remote PC, do the following:

1. Press CONFIG to display the
Configuration menu.

2. Select Network Settings > Web Enable.
Press SEL to select On.
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Installation Variations

3. Set the IP Config Mode to Manual or
DHCP, depending on your network setup.

4. If you cannot use DHCP, set the subnet
mask and gateway address network
parameters in this menu; see your
LAN administrator for required values.
(Be sure to use compatible addresses
between the PC and the instrument.)
You can also set the instrument name
and view the MAC Address.

5. If the password is set, note it. You will
be prompted for it when you connect to
the instrument.

NOTE. For help with entering or changing
the password, select Web Password, and
press the HELP button.

6. Press CONFIG to close the Configuration
menu.

SNMP Setup
If you intend to use SNMP commands to control the instrument (SNMP control is primarily intended for access through
automation systems), you need to set up SNMP parameters.

NOTE. The WFM, WVR, and AMM Series Waveform Monitors wfm_mon.mib and the WVR7120.mib can be downloaded
from the instrument Web page.

The procedure to set SNMP settings is similar to that shown on page 2 for IP settings; the parameters that can be set follow:

SNMP Enable This entry in the Network Settings portion of the Configuration menu allows you to
turn on or off the remote access through SNMP.

SNMP Trap Enable This menu entry allows you to turn on or off the traps that are sent out through SNMP.
SNMP Trap Address This menu entry allows you to set IP addresses to which SNMP traps are sent through

SNMP. Traps can be sent to up to four addresses when error conditions are detected.

NOTE. A value of all zeroes for the address will disable that trap output.
Private Community String This menu entry allows you to set the Private Community string. This string is

effectively a password. Without this string, SNMP commands cannot change values
in the instrument.

NOTE. The Private String is necessary for SNMP access to write changes into
the instrument.
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Public Community String This menu entry allows you to set the Public Community string. This string is
effectively a password. Without this string, SNMP commands cannot read values
from the instrument.

NOTE. The Public String is necessary for SNMP access to read values from the
instrument.

Remote Communication
The following topics cover remote communications that occur:

Over an Ethernet network through a Web browser

Over an Ethernet network through a Java applet

Over a cable using the optional remote front panel

Using a Web Browser
You can use a Web browser to access the instrument and save screen captures, download presets, and download the error
log. Your instrument does need to be connected to an IP network via Ethernet. You will need to set the IP Config Mode, IP
Address, Subnet Mask, and possibly the Gateway Address, to meet your network configuration requirements.

To connect to the instrument using a Web
browser, do the following:

1. Press CONFIG to display the
Configuration menu.

2. Select Network Settings > Web Enable.
Press SEL to select On.
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3. Set the IP Config Mode to Manual or
DHCP, depending in your network setup.

4. Note the IP Address for use in step 6.

NOTE. You may have to set other network
parameters in this menu; see your LAN
administrator if required.

5. Press CONFIG to close the Configuration
menu.

6. Start your Web browser and type the
network address of the instrument (from
step 4) into the URL entry box like this: 1

http://123.123.123.123/

1 Many Web browsers do not correctly interpret IP addresses with leading zeros. If the IP address shown in the Configuration menu
contains leading zeros as in 124.161.038.151, remove the "0" when entering it into the address line of the browser. For example,
124.161.038.151 should be entered as 124.161.38.151.
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Click on the items in the menu to:

1. Start the Java applet (see next
procedure).

2. Display a list of Web clients (by network
address) currently logged into the
instrument.

3. Display a list of the options with which
this instrument is equipped.

4. Display instrument online help.

5. Capture the full or status bar displays
in BMP or PNG formats. Retrieves the
capture for saving to a file.

6. Download and display the Error (Event)
Log as tab-delimited text or an HTML
table.

7. Download and display the Diagnostic
Log or Summary as tab-delimited text or
an HTML table.

8. Download each of the MIB files in ASCII
format.

9. Download the Capture Buffer image in
binary format.

10. Type in the file name of the Capture
Buffer Image file and press the Upload
Capture Buffer Image button to upload it.

Using the Java Applet
To further extend your control from a remote PC, launch the Java applet from the Web browser to change the instrument
settings, display and refresh the instrument screen, save screen captures, download and upload presets, and download
the error log. The Java applet provides a menu bar and a virtual front panel that gives you complete remote control over
instrument settings.

Note that the Web interface operation is optimized for screen resolutions of 1024 x 768 or higher. Operation on computers
with lower resolution requires scroll-bar use to see the entire interface.

Java Applet Requirements

If you install Java on your PC, you can launch a Java applet to control the instrument. The Java Applet requires:

Version 1.6 (or later) of the Java Run-Time Environment (JRE) from Sun Microsystems installed on your PC. To
download the JRE (Java Run-Time Environment) plug-in from Sun Microsystems, download the appropriate code from
the Sun Microsystems URL:http://java.sun.com

Once you download the executable file, launch the installation software and follow the instructions.
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Microsoft Internet Explorer 5.0 or later running on a Windows PC

Netscape on Apple Linux or on UNIX machines

NOTE. If you need remote operation on other platforms, use the Java Application, which is a stand-alone application that
provides all of the features of the Java applet. The Java Application can be run on any platform that supports Java version
1.6 or later, including Windows NT/2000/XP, Linux, Unix, and Mac OS X. The Java application, unlike the Java applet,
does not run within a Web browser and, thus, is not subject to the various browser limitations. You can download the
Java application package from the Tektronix Web site. Look for WFM Remote Software Package in the download section
of the Video Test Product pages.
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Launching the Applet
When you launch the Java applet, it is downloaded from the instrument and launched. There is no software installation
required to use the applet (other than the Java Run-Time Environment noted previously). The instrument supports up to
three remote clients (screen updates become slower with each client added).

1. Launch the Web browser as described
under Using a Web Browser.

2. Once the Remote Interface appears,
select Launch Applet and the Java
applet will be launched.
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NOTE. Your remote Control Panel may
look different than that shown here, but the
same options will be available in a different
arrangement.

3. Use the menu bar of the Java applet
window to quickly access functions that
are not available from the front panel.
Also, access the Configuration menu by
using these menus rather than a front
panel button.

4. For front panel functions, click the virtual
front panel controls to remotely press
most instrument front panel controls.

5. Read the status bar the same way as you
would when it is displayed directly from
the instrument display. (See Determining
Status At-A-Glance in the Quick Start
User Manual.)

Selecting Displays
1. To turn the display of the virtual front

panel on or off, click View > Control
Panel.

2. To turn the display of the Waveform
Display Window on or off, click View >
Waveform Display.

NOTE. The displays can be turned on or off
independently of each other. Here they are
both displayed in the applet window.
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3. To change the refresh rates (defaults are
every 10 seconds), do the following:

Select Options>Settings.

Adjust the refresh rates to the desired
periods in the Settings pop up.

Click OK to save the new rates.

NOTE. You can also display the instrument
online help from the Java Applet. Select
Help > Help... to open online help in a new
browser window.

Operating Notes
1. When adjusting variable settings, such

as vertical and horizontal position or
gain, the Remote Interface displays a
small window with a slider that you use
to adjust the value.
For example, to adjust the vertical
position of a waveform, select Scaling >
Vertical Position and adjust as desired.

2. To allow for display of pop-up menus
for each MEASURE SELECT button,
the Remote Interface provides a menu
button; select the measurement for which
you want to display the pop-up menu.

3. Click the MENU button.

NOTE. You can also resize the virtual
control panel by clicking and dragging the
edges of the panel.

Usage Notes

The Remote Interface Control Panel differs from the instrument front panel in that it provides a menu. The menu provides
many controls, some of which duplicate functions that are directly available from the control panel. See the list that follows.

Menu Commands Description
Active Tile Changes the active tile
Full Screen Changes display to Full screen mode
Capture Captures video data for most of the possible displays in the

instrument (selected from either Freeze or Buffer mode)
Control Panel Toggles the display of the control panel window on and off
Screen Capture Display Toggles the Waveform Display window on and off

View

Refresh Updates the Waveform Display
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Menu Commands Description
Measure Various control items Contents of this menu vary with the selection in the instrument

control panel (WFM, MEAS, AUDIO, GAMUT, VECT, PICT,
OTHER, or STATUS)

Vertical Position Displays a window to enable you to adjust the vertical position
Horizontal Position Displays a window to enable you to adjust the horizontal position
Gain Enables you to set the Gain to 1X, 5X, or set the variable gain
Sweep Enables you to set the sweep mode to One Line, Two Line, One

Field, or Two Field

Scaling

Mag Magnifies the Active Tile sweep rate
Input Inputs and Reference The settings displayed below Input correspond to the controls in

the Inputs and Ref groupings on the control panel
Line Select & Cursors
commands

These menu entries below Options duplicate operation of the
Line Select and Cursors controls on the control panel

Options

Refresh Rate Specifies how often the Waveform Display should be
automatically updated

Configuration Various controls not
available on the front
panel

The menu entries below Configuration duplicate most of the
setups available by display the Configuration menu using the
CONFIG button on the instrument front panel

Control Panel Moves the control panel window to the front if it is covered by
the Waveform Display

Window

Waveform Display Moves the Waveform Display window to the front if it is covered
by the control panel

Help Displays the instrument online helpHelp
About Displays version information about the Java applet
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Display Information
This section describes instrument displays and their respective pop-up menus.

NOTE. All pop-up menus are displayed by pressing the specified button for three seconds. To hide a pop-up menu,
press the specified button again.

Waveform Display
The WFM button displays the Waveform (WFM) display, which is the voltage versus time display used to view a waveform.
You can view the input signal in line or field sweep. You can choose which SDI signal elements are displayed (RGB, YRGB,
or YPbPr), and you can apply filters to the signal. You can also display an SDI input as though it were a composite signal.
You can also control (in the CONFIG menu) whether EAV, SAV, and ANC data is included in the display.

Waveform Display Elements:

1. Is blank when vertical gain is X1;
otherwise indicates that V Gain is x5 or
variable.

2. Lists the currently displayed waveform
color-space. Dashes (--) indicate
components not displayed.

3. Lists the currently selected field and line
(when in Line Select mode).

4. Lists the current sweep rate for tile.

5. Lists the Mag rate if MAG is on.

Waveform Pop-up menu and settings
The Waveform pop-up menu enables you to choose the display style and display mode used in the active tile (SDI inputs
only), select a filter to apply to the input signal, or center the waveform in the display.

To choose a display mode, select from the following the choices (only available while displaying SDI inputs) in the menu:

YPbPr - Displays the input as Luma (Y) and color difference (Pb, Pr) components.

YRGB - Displays the input as Luma (Y), Red (R), Green (G), and Blue (B) components.

RGB - Displays the input as Red (R), Green (G), and Blue (B) components.

SDI > Composite - Displays the SDI input as if it has been encoded into composite. The sync and burst in this mode are
synthetic and convey no information about signal quality.

When viewing 525-line SDI input as a composite waveform while using line select mode, both burst phases may appear
when you would expect to see only one. This is because the line selection in SDI Mode is an odd/even selection, and
composite signals are normally viewed with a one-of-four or one-of-eight line selection.
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To choose how the signal components are displayed in the active tile, use the Display Style menu setting (SDI inputs
only) to select:

Parade style - has all the components shown one beside the other.

Overlay style - has all the components drawn at the same location so that they appear one on top of the other.

The Waveform pop-up menu Filter selection allows you to select filters to be applied to the video. This is useful for isolating a
specific characteristic of the input. For example, to measure amplitude, you may want to use a Luma or Low pass filter
to remove the high frequency components.

To choose a filter select one of the following filters from the Waveform menu:

Flat - Display with the full available bandwidth.

Luma or Low Pass- Display only the low-frequency portion of the signal.

Chroma - Display only the portion of the signal with frequencies near the color sub-carrier. For Composite inputs only.

Flat + Luma - A combination of a Flat and a Luma waveform from a Composite input; it shows two waveforms
in parade configuration.

NOTE. For SDI displays, such as RGB mode, the available filters are Flat and Low Pass. For Composite displays, the
available filters are Flat, Luma, Chroma, and Flat+Luma.

To cancel any horizontal or vertical position adjustments and restore the trace to the default position, select Center
Waveform and press SEL. For a tile in WFM mode, this puts the baseline at the zero graticule.
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Vector Display
The VECT button calls up the Vector and Lightning displays, which provide for selection between two plots of the color
portions of the signal. The following elements appear on the display. Most appear on both Vector and Lightning displays.

Lightning Display Elements:
1. V Gain. Press and hold the GAIN button

to select V Gain settings. Then select
the gain to 1X, 2X, 5X, 10X, or Variable.
(Variable enables you to adjust the
vertical gain using the GENERAL knob.)

Lightning & Vector Display
Elements:
2. H Gain. Press and hold the MAG button

to select H Gain Settings. Then select
the horizontal gain to 2X, 5X, 10X, or
Variable. (Variable enables you to adjust
the horizontal gain using the GENERAL
knob.)

3. Display Type. The selected display,
either Lightning or Vector.

4. Bar Target Setting. The bar target
setting, either 75% or 100%.

5. Phase. Appears in Composite Vector
inputs only.

Vector Pop-up Menu
The Vector pop-up menu enables you to specify the display type and display mode (SDI inputs only), to set the bar targets,
and to center the waveform in the display.

To choose the display type (SDI inputs only), use the pop-up menu to choose either:

Vector - The Vector display shows a plot of the R-Y signal on the vertical axis and the B-Y signal on the horizontal axis.
This display is useful for looking at hue and saturation of the colors, but does not show luminance information.

Lightning - The Lightning display shows the same color signals as in the Vector mode, but they are plotted versus
luminance. One color difference signal is plotted in the top half and the other in the bottom. Lightning is useful for
checking chroma and luma gain, and for checking chroma to luma delay using the timing marks that show errors in the
green to magenta transition on a color bar signal. This is a Tektronix proprietary display and is for SDI signals only.

To select which scaling should be used in the active tile for either the Vector or Lighting display, use the menu to select
75% or 100% scaling.

To cancel any horizontal or vertical position adjustments and restore the trace to the default position, use the up/down arrow
keys to select Center Waveform in the menu.

For a Lightning display, press SEL to center the waveform. The trace is set back to the center of the tile.
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For a Vector display, press the right-arrow key to select the color you want to locate at the center of the display.

For additional vector graticule options, see the Configuration > Graticules menu and select I/Q axis or Compass Rose.

Timing Display
Pressing the MEAS button displays a Tektronix proprietary display that simplifies measuring the timing difference between
two signals as the timing is corrected. Using the Tektronix Timing display enables you to easily compare and correct the
timing between two signals.

Display Elements:
1. Input Signal Indicator: A single 1

circle representing timing of input signal
relative to the reference.

2. Reference Indicator: A cross-hair
indictor centered in the display
represents the reference signal.

3. Vertical Offset: The timing difference
between the reference and input signal.

4. Horizontal Offset: The timing difference
between the reference and input signal.

5. Relative to: Indicates the chosen zero
point for the timing display. 2

1 More complex timing relationships display multiple circles. See Timing Displays for Simple Versus Complex Timing.
2 Rear Panel is the default setting, where offset is shown as zero when the input and reference are at the same timing at the rear panel of the

instrument. If you select Saved Offset, you can save the timing from one signal, and then display the timing relative to that saved offset.

Measure Pop-up Menu
The Measure pop-up menu enables you to save a timing setting for comparison with another signal and specify the zero
point of the timing display.

To save the timing of the current input as an offset to the timing display, use the Save Offset menu entry. The current timing
becomes the zero point for the saved offset mode of the timing display. This applies to both the cross-hair target in the
middle of the display and the numeric readouts.

NOTE. You cannot save the timing offset if either the input or reference is missing or unlocked. You also cannot save a
reference when in internal mode. Saving an offset in these conditions would lead to misleading results so it is not allowed by
the instrument. A warning message will appear on the screen if you attempt to save the offset when it is not allowed.

Save Offset allows you to measure the timing between inputs or to match multiple signals. To select the definition for the
zero timing offset, use the Relative To: menu entry to select one of the following:
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Rear Panel, which means the timing offset will be shown as zero when the two signals are timed down at the rear
of the instrument.

Saved Offset, which means that the timing will be shown as zero offset when the input signal matches the timing of the
signal that was present when the offset was saved using the Save Offset menu entry.

This selection changes both the numeric readouts and the target in the middle of the timing display.

Timing Displays for Simple Versus Complex Timing

The number of circles, with each representing
a time offset, varies with the complexity
of the timing between the reference and
input signals. If you are timing input signals
with rates that are integer multiples of the
reference rates, the instrument can measure
the timing deterministically and displays the
relationship as one circle (offset) relative to
the cross-hair (reference as is shown).
Such cases include timing an NTSC input
(multiplier of 1) or a 525 SDI input whose
frame time is 33.36 ms (multiplier of 2),
against an NTSC reference, which has a
frame time of 66.73 ms.

If you time input rates that are not
integer multiples of the reference rates,
the instrument cannot measure the
timing deterministically, so it displays the
relationships as several circles. Each
circle represents a possible timing offset
measurement relative to the reference
cross-hair. Display emphasis is given to the
circle that times closest to zero offset and the
numerical readouts track this pair.
Nondeterministic cases include timing of
slow rate inputs against fast frame-rate
references or when timing video against film
rates.
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For a case where multiple relationships would
display, consider an input of 1080p/23.98
Hz with a reference of NTSC/59.94 Hz:

The different rates result in timing
relationships between the signals that
repeat once for every four fields of the
input and five frames of the reference
(shown right).

Because this allows for five possible
ways to measure timing between these
two signals, the timing display shows
four circles, with emphasis and readouts
as previously described above.

Picture Display
Pressing the PICT button calls up the Picture display, which lets you see the picture generated by the video signal. You
can choose to display the picture with or without a Picture Frame, VChip, Closed Captioning (CC), Teletext, and Safe
Area Graticules.

Display Characteristics:
In full-screen mode (shown), there is no
cropping.

Pictures are decimated horizontally or
vertically to achieve the correct aspect
ratio. This decimation may cause some
artifacts. This behavior may be evident
on a sweep signal.

Also see the online help for the Picture
Aspect Ratio for related information.

Display can be set to include Closed
Captioning text orTeletext subtitles
overlaid on the picture.
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VChip, CC-Display, Teletext,
and Safe Area Graticule
Characteristics:
1. VChip Area: Displays detected VChip

ratings from any of these systems: MPAA
(US), TV (US), Canadian English, and
Canadian French. VChip information is
labeled CA (Content Advisory).

2. Safe Graticules: SMPTE, BBC, and
ARIB B-4 standards for safe area
graticules allow for selection of up to two
Safe Area and two Safe Title graticules.
Custom graticles with adjustable areas
can also be specified.

3. Closed Caption Text and Teletext
Area: Displays closed captioning or
Teletext, configurable to decode to the
following Closed Caption and Teletext
standards:

For Composite: EIA-608-line-21
(VBI), TeletextB VBI (PAL)

For SD: EIA-608-line-21, EIA-608
(ANC), EIA-608 (708), EIA-708, and
TeletextB VBI (625)

For HD: EIA-608 (ANC), EIA-608
(708), EIA-708, TeletextB VBI,
TeletextB OP47 SDP (ANC), and
TeletextB OP47 Multi (ANC)
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NOTE. See Monitoring Closed Captioning (CC), Teletext, and Safe Area Compliance in the Quick Start User Manual.

PICT Pop-up Menu
The Picture pop-up menu enables you to optionally display elements of the video signal outside the active video, turn on
display of Close-Caption (CC) text or Teletext overlaid on the picture, and turn on up to four save area graticules, and
otherwise control the PICT display.

To see only the active video portion of the signal, use the menu to switch Picture Frame to On; to see elements of the signal
outside the active video, switch Picture Frame to OFF to view user data, embedded audio, and elements in the vertical
interval.

NOTE. You can see signal elements outside the active video only when the PICT display is set to FULL. You will not be
able to see sync signal elements on Composite signals.

To view CC text overlaid on the display, use the menu to switch Display Closed Captions to ON.

To select the CC service used to display closed captions, use the menu to set EIA-608 CC Service to a CC or text channel.

NOTE. If you set a PICT display for additional tiles, each one affords independent control of the CC setup. You can turn it
on for one tile and leave it off for another, or you can set it to display differently from one tile to another. Conversely, CC
configuration set in the CONFIG menu applies globally to all tiles set to PICT.

NOTE. To set the global configuration for CC decoding, use the Aux Data Settings submenu of the CONFIG menu. You can
set the CC transport type and other global parameters. See Monitoring Closed Captioning and Teletext in the Quick Start
User Manual for more information.

When monitoring to ensure that branding or other elements do not overlay essential text or video action, use the PICT menu
to select a Safe Action and Safe Title graticule. The Safe Action Area is the maximum image area within which all significant
action should be contained, and the Safe Title Area is the maximum image area within which all significant titles should be
contained. You can select standard or custom safe area graticules.

To display safe area graticules overlaid on the display, use the menu to switch up to four Safe Area graticules settings to ON.

NOTE. Select and/or define these graticules globally in the Graticules submenu of the CONFIG menu. You can set the
Safe Graticule Standard and define dimensions and offsets for custom Safe Graticules. See Monitoring for Safe Area
Compliance in the Quick Start User Manual for more information.
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Audio Display
Pressing the AUDIO button brings up the Audio Display. The Audio display provides level meters and a phase display for
monitoring audio signals. The Audio display always shows the level meters and correlation meters. When you choose to
display the phase plot (also known as Lissajous), the left portion of the Audio tile displays the level meters and the right
portion the Phase display. You can have the instrument display Surround Sound in the right part of the Audio Tile, instead of
the phase plot. See the figure that follows.

Display Elements

Element Descriptions

Element Description
Level meters Can include Dolby channels 9 and 10 if Dolby options are present.
Phase or Surround display Selects between the Phase display, where the phase of a selected pair of

channels is plotted against an X-Y or sound-stage plot, and the Surround
Display, where all the channels levels display in positions matching their
place in a surround-sound listening environment.

Audio source/setup Displays selected audio input and related setup information, such as
Listening Mode when in Surround display.
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Element Description
Level meter labels Identifies the signal in each meter bar. The labels vary according to

whether the audio sources to the level meter bars are normal channel
pairs, surround channels, or Dolby sources (the Dolby source labels
include Dolby type).

Level meter ballistics readouts Displays the selected dynamic response characteristic.
Axes Shows the orientation of the two audio signals when displaying phase;

shows the orientation and amplitudes of the sound field when displaying
surround sound. (Axes are selectable for an X-Y or Soundstage plot.)

Phase correlation meters Displays the phase correlation between the two-channel bars under which
it appears. The meter of the pair selected for the Phase display also
appears in the Phase display.

Test level and Peak program level indicators Indicate, as diamond-shaped markers between the level bars, the
configurable limits set up for the display. Above the Test level, the bar
displays in a yellow color. Above the Peak level, the bar displays in a red
color. Test level is also known as Reference level or Line-up level.

Level meter scale and units By default, the units are in dB relative to full scale (dBFS) for digital inputs
and dB relative to 0.775 Volts (dBu) for analog inputs. The 0 dB mark is
digital Full scale for digital inputs and 0 dBu for analog inputs. You may
also set the 0 dB mark to either the Peak Program level or the Test level.
See also CONFIG > Digital Audio Display > set meter type to, and CONFIG
> Analog Audio Display > set meter type to.

Dolby Guardband thermometer Guardband limits can be set for SD, HD, 3G, DL, and CMPST signals. A
Dolby Guardband thermometer is displayed on the Audio display so that
you can monitor whether or not guardband limits are being exceeded.

NOTE. The surround display is described under Monitoring Surround Sound in the Quick Start User Manual.

NOTE. The loudness measurement supports three types of filters: Flat, A-weighted, and RLB (ITU-R BS.1770). The
measurement can be viewed in the Audio Session display and configured in the Audio pop-up menu.

Above-bar Warning Messages
This instrument displays warning messages above the level meter bars. The warning messages that can appear above
the bars as follows:

Clip. The number of consecutive samples equals or exceeds the # Samples for Clip setting.

OVER. The signal has been at or above the specified Over Level for a time exceeding the Duration for Over setting.

In-bar Warning Messages
This instrument displays warning messages within the level meter bars. The warning messages that can appear are
shown below in order of priority.

UNLOCKED. The instrument is not locked to an incoming signal on the indicated input channel. Data cannot be decoded
and all data and other errors are ignored. This means that if an AES input is selected, nothing recognizable is present on
the input, or if embedded audio is selected, the VIDEO input is unrecognizable.
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AES PARITY. The incoming subframe does not have even parity as specified by the digital audio standards. The data sample
is unreliable and is ignored. The level meters and Lissajous display treat the sample as a zero sample.

AES CRC ERROR. The CRC code in the AES channel status packet is incorrect. Sometimes the CRC code is set to zero,
indicating that the signal is missing; when this is the case, this message is not displayed.

MUTE. The number of consecutive all-zero samples equals or exceeds the # Samples for Mute setting.

SILENCE. The signal has been at or below the specified Silence Level for a time exceeding the Duration for Silence setting.

DISABLED. Indicates that an audio bar is not active. This message is mainly seen with a Dolby Digital source when a
listening mode is selected with a reduced number of channels.

AES V BIT. Indicates that the Validity bit is set high for one or more data samples. In the AES/EBU standard, a set validity
bit indicates that the sample is not suitable for conversion to audio. By default, the level meter bars and Lissajous display
treat the affected samples as zero samples.

NO AUDIO. Indicates that an AES or embedded input has the Non audio bit set.

NOT PRESENT. Indicates that an audio bar is not present in the current audio input. This can be present if a Dolby Digital
input has a coding mode indicating a reduced number of channels.

DOLBY D. Indicates an AES or embedded input is Dolby Digital.

DOLBY E. Indicates an AES or embedded input is DOLBY E.

Audio Pop-up Menu
The Audio pop-up menu enables you to select the audio input source and specify whether a phase display or a
surround-sound displays appears in a subtile to the right of the level meter display.

To select the source for the Audio display, select Audio Input in the menu and set a source. The number of available
sources depends on which audio option is installed. Choosing any given input will make that audio the monitored signal
regardless of which video input is active. Alternatively, you can choose Follows video to enable the mapping that allows
changing the audio source as the video input selection is changed.

NOTE. Use the CONFIG menu to select the mapping of input to bar, the meter type, and the Follows video mapping of
audio to video.

Headphone input maps audio pairs to thee front panel headphone jack.

Analog Out Atten is used to adjust the levels to the rear panel analog outputs.

To add a 2-channel phase display to the audio tile, set Aux Display to Phase Display in the Audio pop-up menu. A phase
display is also called a "Lissajous" display.

To choose the plot style of the Phase Display, select between the following two entries in the pop-up menu:

Sound Stage has axes rotated at a 45 degrees.

X-Y has axes that are horizontal and vertical.

To choose the pair of inputs that is displayed in the phase display, select Phase Pair and set a value. You can also select
Custom, and then specify individual channels for the input pair, using the Phase Channel A and Phase Channel B entries.

To add a multi-channel surround sound display to the audio tile, set Aux Display to Surround Sound in the Audio pop-up
menu. You can also enable either or both of the following entries:
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Dominance Indicator. When on, indicates the location of the dominant sound in the surround sound image using a
cross-hairs pointer (surround display only).

Loudness. When set to Flat, results in a non-weighted response; when set to A-weighted, results in a response that
more closely matches that of the human ear.

NOTE. The Audio Surround Sound display is courtesy of Radio-Technische Werkstaetten GmbH & Co. KG (RTW) of
Cologne, Germany. Surround Sound: Radio-Technische Werkstaetten GmbH & Co.
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Gamut Display
Pressing the GAMUT button calls up the Gamut Display. The Gamut display provides three proprietary Tektronix display
types to enable you to easily and quickly check the gamut of an SDI signal. You can choose from the Arrowhead, Diamond,
and Split Diamond displays. The Arrowhead display provides NTSC and PAL composite gamut information directly from the
SDI signal. The Diamond and Split Diamond displays provide a reliable method of detecting invalid colors.

Display Elements:

1. High threshold: Shows the currently
specified high threshold (Diamond High
or Arrowhead Max).

2. Low threshold: Shows the currently
specified low threshold (Diamond Low).

3. Gamut display type: Shows the
selected Gamut display type - Diamond,
Split Diamond, or Arrowhead.

4. Threshold indicators: Indicates the
threshold settings using blue dashed
lines.

GAMUT Pop-up Menu
The GAMUT pop-up menu allows you to select the type of gamut display shown in the active tile. To change the display type
in the GAMUT display, use the pop-up menu to select from the following displays:

Diamond shows Gamut violations of the SDI input if translated to RGB color space.

Split Diamond offsets the two halves of the Diamond to allow you to better see negative RGB Gamut errors.

Arrowhead shows Gamut violations of the SDI input if translated to the Composite domain.
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Status Display
Pressing the STATUS button calls up the Status display, which provides several views of signal status. Status displays are
text displays that show signal status. You can view current alarms and errors (those occurring now and within the last few
seconds), a history of errors and alarms (up to 10,000 entries), video error statistics or audio error statistics. You can display
a different Status display type in all four tiles.

NOTE. Press the HELP button and then press the STATUS button to explore help topics on the following status types.

Status display types available:

1. Video Session: Control the Video
Session settings.

2. Audio Session: Control the Audio
Session settings.

3. Aux(iliary) Data Status: View
closed-caption, teletext, video index,
AFD, WSS, and V-chip related status.

4. Dolby Status: View Dolby metadata
for the currently monitored audio source
(AES and embedded inputs).
For instruments equipped with Option
DDE, Dolby Timing and Dolby VANC
data is available. For the latter, you can
select to view metadata from the audio
data stream or from the VANC.

5. Error Log: Control the error logging
settings.

6. Alarm Status: View current alarm
status.

7. ARIB Status : Check for the presence
and status of ARIB-based information
encoding. The instrument supports
TR-B.22, TR-B.23-1, TR-B.23-2, B.35,
B.37, and B.39 ARIB standards. To view
the ARIB content displays, enable this
option in CONFIG > Aux Data Settings
> ARIB Content Display.
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8. SDI Status: View two measurements
of signal jitter cable loss in both dB
and meters of the selected cable type,
and calculated source level. With
option PHY, automatic measurements
of eye amplitude, rise time, fall time,
overshoot, and rise-fall difference are
also displayed.

9. Audio Control: View the information
on audio frame number, sampling
frequency, active channels, and relative
audio-to-video delay of each channel,
as encoded in the audio control packet
metadata.

10. Audio Channel Status (Option AD and
DDE): View the specified channel in the
specified format.

STATUS Pop-up Menu
The STATUS pop-up menu enables you to mute alarms, select the type of display that appears in the status screen, and set
options related to the selected display type.
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STATUS Colors
The STATUS display messages and values appear in different colors to help indicate signal status:

Color Description
White Identifies informational items and represents changes in the instrument

state
Green Indicates error conditions that have cleared
Yellow Indicates that there is a warning condition (that might require attention) or

that an error has occurred within 2 seconds
Red Indicates signal information that has been found to be in an ongoing error

state
Gray Indicates alarm status state of an disabled alarm

Alarm Status Errors
When RGB and/or Composite Gamut errors are detected, the associated lines in the Alarm Status display have characters
that indicate which gamut threshold(s) are exceeded for each component. The following error codes that may be displayed:

NOTE. To monitor alarms remotely, use a PC to monitor SNMP traps over the Ethernet port (the PC must have SNMP
trap service installed). Before SNMP traps can be sent, you must enable and configure the instrument for SNMP control
using the Network Settings submenu of the CONFIG menu.

Indicator Description
R Signal exceeds the high gamut limit for the red component (RGB gamut)
r Signal exceeds the low gamut limit for the red component (RGB gamut)
G Signal exceeds the high gamut limit for the green component (RGB gamut)
g Signal exceeds the low gamut limit for the green component (RGB gamut)
B Signal exceeds the high gamut limit for the blue component (RGB gamut)
b Signal exceeds the low gamut limit for the blue component (RGB gamut)
C Signal exceeds the high gamut limit for the chroma component (composite gamut from

SDI input)
c Signal exceeds the low gamut limit for the chroma component (composite gamut from

SDI input)
Y Signal exceeds the high gamut limit for the luma component (composite gamut from

SDI input)
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Indicator Description
y Signal exceeds the low gamut limit for the luma component (composite gamut from

SDI input)

Diagnostics Log
This log contains the results of diagnostics tests, boot-ups, and advanced diagnostics that were performed. View the
log directly on the instrument by pressing CONFIG >Utilities > View Diagnostic Log, or by clicking on the Diagnostics
Log link on the Remote Web page.

Error Log
The instrument maintains an error log (also called the event log) in which every logged entry is time-stamped. When you
enable Timecode, events are time-stamped with the timecode embedded in the video (or LTC) signal. Enable Timecode from
the Aux Data Settings submenu of the Config menu. View the log directly on the instrument by pressing Status > Error Log,
or by clicking on the Error Log link on the Remote Web page.

CAUTION. The time of day time stamps in the error log are based on the system time of the instrument when the logging
process starts. Changing the system time of the instrument while the error log is in the Running mode does not change the
time stamps in the running error log. You must stop and restart the error log before the error log will use the new system time.

Error log size. The error log can contain up to 10,000 entries. Recording each individual event separately would quickly
fill the log. To handle this problem, the instrument classifies log entries as one of the following:

Single shot. One isolated occurrence is logged as one entry.

Continuous. Uninterrupted sequence of occurrences is logged as two entries marking the beginning and end of the
sequence.

By default, alarms are not enabled for logging. Use the Alarm Setup submenu of the Configure menu to select the number of
monitored error conditions.

Waveform Monitors Technical Reference 31



Display Information

Eye Display
For instruments equipped with Option EYE, pressing the EYE button calls up the Eye display (for SDI inputs only). The Eye
display presents an eye pattern diagram of the SDI input, which lets you verify electrical characteristics of the SDI transport
layer. You can measure analog characteristics of the SDI input on the eye pattern using the graticule or voltage and time
cursors. Two jitter indicators provide two independent measurements of jitter. You can also set alarms on various parameters
(see your instrument online Help). For more information on jitter, search the Tektronix Web site for jitter application notes.

NOTE. If your instrument has Option 3G, you can use the Recover Clock Out output to trigger a connected oscilloscope to
make an eye pattern.

Display Elements:

1. Eye Pattern: Displays a waveform you
can use for SDI transport verification and
analysis.

2. Jitter Thermometer: Displays jitter
value and relates it to alarm limits.

3. Equalized Eye Indicator: If enabled in
the CONFIG menu, the Eye pattern is
equalized, reducing the jitter noise floor.
Amplitude Cursor measurements do not
indicate the actual signal amplitude.

4. Cursor Readouts: Provide for direct
measurements of amplitude and time on
the Eye.

5. Eye Pattern Type: Either 3 Eye, or 10
Eye (SD)/20 Eye (HD). The latter types
can help reveal when jitter at the parallel
word rate is present.

6. Jitter HPF: Indicates the setting for the
Jitter High Pass Filter, set in the CONFIG
menu.

At the end of a long cable, the eye diagram may appear so noisy that there is little or no discernible opening. In this situation,
limited use of the eye diagram is still possible by selecting Equalized Eye mode. The equalizer compensates for the effects of
cable length by applying an inverse response function and then reslicing the signal to a logic level. This causes amplitude
information to be lost, but preserves the effects of jitter in the signal.

If the equalized eye display appears clear with a substantial eye opening, then the signal is likely to be recovered error-free.
However, if it appears noisy with little eye opening, then there is more potential for data errors to occur in the receiver.

NOTE. For information on taking Eye measurements, see the Monitoring the SDI Physical Layer section of the Quick
Start User Manual.
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Eye Pop-up Menu
Pressing the MEAS button on the front panel will bring up the Eye pop-up menu. This menu enables you to center the eye
waveform and, more importantly, specify the operation of the Jitter detector that drives the Eye display.

NOTE. Eye diagrams that you display in the upper two display tiles are driven by the Jitter1 detector; those in the lower
two tiles, by the Jitter2 detector. To display two Eye diagrams with independent Jitter detectors, display one in an upper
tile and one in a lower tile.

Jitter Display
The Jitter Display can be used once you have configured the instrument for Eye measurements and is only available with
option PHY. This display shows you the wave shape of the jitter and allows you to view additional time-domain information,
such as whether there are jitter components that are synchronous or nearly synchronous to the video line or frame. You
can also set alarms on various parameters (see your instrument online Help). For more information on jitter, search the
Tektronix Web site for jitter application notes.

Display Elements:
1. Jitter Waveshape: Displays the jitter

wave shape (the image to the right
shows no jitter). This shape is modified
by the high-pass filter (HPF) setting.

2. Jitter Thermometer: Displays jitter
value and relates it to alarm limits.

3. Jitter HPF: Indicates the setting for the
Jitter High Pass Filter, set in the CONFIG
menu.
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High-Pass Filter. The high-pass filter bandwidth setting allows you to show only jitter terms above the selected filter
frequency. When you select a filter setting, depending on the active input signal, you select the jitter measurement type
(Timing, Alignment, or neither, as defined by the SMPTE standard). Use the High Pass Filter soft key to select the lowest
settings to measure timing jitter and the higher settings to measure alignment jitter.

To choose the Jitter detector filter, use the Measurement pop-up menu and choose one of the following settings for
the Jitter HP Filter entry:

Setting Description
Timing Sets the detector high-pass filter to 10 Hz. This is the correct value for

measuring timing jitter for both SD and HD signals.
Align Sets the detector high-pass filter to 1 kHz, as specified by SMTPE, for SD

signals; and to 100 kHz for HD signals. These are the correct values for
measuring alignment jitter.

10 Hz, 100 Hz, 1 kHz, 10 kHz, 100 kHz Sets the detector high-pass filter to the selected value.

Jitter Pop-up Menu
The Jitter pop-up menu is accessed by pressing the MEAS button on the front panel. This menu enables you to set the Jitter
HPF value, center the waveform, show or hide the meter readout, and change the display type.

NOTE. For instructions on how to take jitter measurements, see the Taking Jitter Measurements section in the Quick
Start User Manual.
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Ancillary (ANC) Data Inspector
The ANC Data Inspector is part of the ANC Data Display and is available on instruments with Option DAT. This ancilliary
monitoring feature allows you to see all ancilliary data present in a signal. The instrument continually monitors the signal
and tells you when changes in the presence of data occur. When Watch List mode is activated, the instrument will display
the presence and status of ANC data types you have selected in the Watch List. This allows you to focus on the ANC
data types that are important to you.

Elements of the ANC Data Display . The following information is available on the ANC Data Display:

DID: Data Identifier of the requested packet; permissible values range from 1 to 0xFF (255) inclusive

Type: Type of the ANC Data packet; either Type 1 packet (DID greater than or equal to 0x80), or Type 2 packet (DID less
than 0x80), as defined by SMPTE 291M; Type 1 packets do not have a SDID field, instead they have a DBN field; the
"actual value" (with parity bits added) is displayed in parentheses

SDID: Secondary Data Identifier of the requested packet; permissible values range from 0 through 0xFF (255) inclusive;
this field only appears when a Type 2 packet is selected; the "actual value" (with parity bits added) is displayed in
parentheses (mutually exclusive with DBN field)

DBN: Data Block Number of the acquired packet; values range from 0 to 0xFF; the "actual value" (with parity bits added)
is displayed in parenthesis (mutually exclusive with SDID field)

DC: Data Count word of the acquired packet; the number of User Data words is displayed in decimal; the "actual value"
(with parity bits added) is displayed in parenthesis, in hexadecimal

Field: The field of the video from which the packet was acquired; for progressive formats, 1 is displayed

Line: The line of the video (within the field) from which the packet was acquired

Stream: For HD (SMPTE 292M), indicates whether the ancillary packet was acquired from the Y or C data streams;
for SD, "N/A" is displayed

Status: Indicates whether packet(s) of the desired type are present in the video; also indicates Checksum or CRC errors

Checksum: Indicates the checksum word that was recovered from the acquired packet

Should be: Indicates the checksum work computed by the instrument, based on data of the packet

Format: Indicates the name of the ancillary data type or standard

User Data Words: Contains the payload of the ancillary packet, displayed in hexadecimal; all 10 bits are displayed

Waveform Monitors Technical Reference 35



Display Information

Configuring the ANC Data
Inpsector
1. Press a Display Select button. To view

the selected tile full screen, press the
FULL button.

2. Press the CONFIG button and use the
General knob to navigate to ANC Data
Display.

3. Press the up arrow key to highlight User
ANC Types. You can configure up to
eight user types.

4. Use the arrow keys and the General
knob to select the SDID or DID hex
values for each Type.

5. You can also select Name to enter a
name for a user defined type. When the
dialog box appears, enter the name of
the ancilliary data type.

6. When you are finished, mark the Accept
box and press the SEL button.

7. Press the CONFIG button to dismiss the
configuration menu.

8. Press the down arrow key to highlight
Config Watch List.

9. Press the SEL button to view the Watch
List menu.

10. Use the General knob to navigate to the
ancilliary data type you want to specify
on the Watch List in the ANC Data
Inspector.

11. Press the SEL button to mark the data
type you have chosen with an X.

12. When you are finished, use the down
arrow key to navigate to the Return
square.

13. Press the SEL button.
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14. Press and hold the MEAS button to
access the Measurement pop-up menu.

15. Navigate to Display Type using the
up/down arrow keys or the General knob.

16. Press the right arrow key to navigate to
the Display Type submenu.

17. Use the up/down arrow keys to select
ANC Data Disp.

18. Press the left arrow key.

19. Press the up arrow key to highlight View
Mode.

20. Press the SEL button to highlight Watch
List.

21. Press the MEAS button to dismiss the
pop-up menu.
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22. Use the arrow keys or the General knob
to highlight the ANC data type for which
you want to view details. The details
will appear in the bottom portion of the
display.

23. Press the right/left arrow key to activate
the Detail portion of the display. A blue
border will appear around the portion of
the display that is active.

24. Use the General knob or the up/down
arrow keys to scroll through the selected
ANC data type details.

25. To expand the detail list, press the MAG
button.

Using the ANC Data Inspector with CaptureVu™. When you use CaptureVu™ with the ANC Data Inspector, the
instrument will display all of the ANC data packets for the complete frame of stored data for each of the present ancillary
data types. This allows you to investigate problems within the signal and verify that the ancillary data present within the
buffer is correct. Use the arrow keys to navigate the various windows and the MAG button to expand the Detail view of
the ANC Data user words.

After you have configured the ANC
Data Inspector as shown in the previous
procedure, you can perform the following
steps.

1. Check that the ANC Data Inspector is
displayed.

2. Press and hold the CAPTURE button to
display the capture menu.

3. Navigate to Capture Type and select
Buffer.

4. Navigate to Delete & Capture and press
the SEL button to capture the signal.
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5. Navigate to Display Mode and select
Buffer Only.

6. Press the Capture button to dismiss the
pop-up menu.

You can now view the ANC Data packets
for the highlighted ANC data type in a single
display.
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Supplemental Operating Information
This section contains topics that, though of less general interest, may address your particular application needs. These
applications include cloning setups, upgrading firmware, and a description of cable types.

Importing and Exporting Presets
Given the complexity of SDI and other Video signals, instrument setups can become complex as you tailor them to monitor
the parameters you want. To save setup time and ensure consistency, you can save instrument setups as presets in your
instrument. For the same reasons, you might also want to clone (save) setups to use in setting up other instruments. You
can do this by saving Presets to the USB drive.

USB Mount/Unmount
Pressing the Main button provides access to the USB Mount and Unmount options. Remember to unmount the USB drive
before physically removing the memory device to avoid loss of data.

Exporting Presets to a USB Memory Device
If you want to export presets to a USB memory device, perform the following steps:

1. Insert a USB memory device into the USB drive located in the front of the instrument. To check that the drive mounted
properly, press the MAIN button. The menu selection should say USB Unmount > Press Select. If that is what you see,
press the MAIN button again to dismiss the pop-up menu.

2. Press and hold the Preset button to view the pop-up menu.

3. Press the down arrow key and select Export Presets.

4. Press the right arrow key to access the submenu and then press the up/down arrow keys to navigate to Select Source.

5. Press the right arrow key to access the submenu, highlight the Preset Group you what to export to the USB memory
device, and then press the SEL button.

6. Navigate to the Select Dest menu option and use the arrow keys to access the submenu.

7. Select a USB folder if one exists, or create a folder by following the instructions for the Create USB Folder menu
selection.

8. In the same submenu, navigate to the Preset Group that matches the source Preset Group and press the SEL button.

9. Press the left arrow key and then the down arrow key and highlight Copy.

10. Press the SEL button. You should see a pop-up notice that says Export Complete.

11. If you do not want to export any other presets at this time, press the down arrow key to highlight Unmount USB
and then press the SEL button.

12. Press the Preset button to dismiss the pop-up menu.

13. Remove the USB memory device from the USB drive.
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Importing Presets from a USB Memory Device
To import presets, use the procedure for Exporting presets with the following exceptions: select Preset > Import Presets,
select the folder on your USB memory device as the source, and select the corresponding instrument preset folder for the
destination.

Upgrading Instrument Software
System Upgrade (CONFIG > Utilities > System Upgrade) is used to upgrade the system software of this instrument. The
upgrade is performed across an Ethernet network or using a USB memory device.

PC System Requirements
The data-transfer utility for upgrading the instrument runs on these PC systems: Windows 98, Windows NT 4.0, Windows
ME, Windows 2000, and Windows XP.

The data-transfer utility also requires Winsock 2.0, an Ethernet interface, and 30 MB of free disk space be present on the
PC system or USB memory device.

USB and Network Upgrades
You can upgrade the instrument software using a PC or through the USB drive on the instrument. The following procedures
explain how to do both.

USB Upgrade
Download the latest version of the instrument
software to a USB memory device by
performing the following procedure:

1. Using an Ethernet connection on a PC,
navigate to the Tektronix Web site at
http://www.tek.com/products/video_test.

2. Click on the Download Software link,
and then select the Video/Audio Signal
Monitors link. This will give you a list of
available downloads.
Sort by Date Added to get the most
current version of software and then
find your instrument model for the
software-upgrade package you need.
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3. Download the file and save it to a USB
memory device that is compatible with
your waveform monitor.
Save the package into a directory named
WfmUpgrd.

Download the firmware onto your instrument
from the USB memory device by performing
the following procedure:

4. Insert a USB memory device into the
USB drive of the instrument.

5. Press CONFIG > Utilities > System
Upgrade > Upgrade Options > USB
Upgrade and then press the SEL button.
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6. Select Continue when the message
appears confirming the presence of the
WfmUpgrd directory on the USB memory
device.
The instrument should automatically
reboot when the upgrade is complete.

Network Upgrade
Download the latest version of the instrument
software to a PC by performing the following
procedure:

1. Using an Ethernet connection,
navigate to the Tektronix Web site at
http://www.tek.com/products/video_test.

2. Click on the Download Software link,
and then select the Video/Audio Signal
Monitors link. This will give you a list of
available downloads.
Sort by Date Added to get the most
current version of software and then
find your instrument model for the
software-upgrade package you need and
download the package.

3. Click the downloaded archive and extract
the archived files into a directory of your
choice. The files to be extracted are
transfer.exe and readme.txt.

4. Extract the following files: transfer.exe,
firmware.pkg and readme.txt.

5. Press CONFIG > Utilities > System
Upgrade > Upgrade Options > Network
Upgrade and then press the SEL button.
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6. On the PC, double-click the transfer.exe
file to launch the transfer program. This
displays the window shown at right.

7. Type the network address (for example:
128.181.221.002) or DNS name of the
instrument you want to update. Make
sure to delete any leading zeroes, as
shown in the example in the illustration.
Press Enter.

8. The transfer utility displays done when
the software upgrade completes.
When the software upgrade completes,
the instrument will reboot.

9. To update another instrument, type the IP
address of that instrument at the prompt
and press Enter on your PC keyboard to
start the software upgrade. If you won’t
be updating another instrument, press
Enter to exit the transfer utility.
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Upgrading Multiple Instruments With a PC
You can upgrade several instruments in one session, one at a time, if you have determined their addresses. To upgrade,
use the Windows Command Prompt. Enter the following line in a Command Prompt window (substituting the addresses
of your machines):

transfer.exe 192.181.115.1 192.181.115.2 192.181.115.3

Separate the addresses with a space.

Alternatively, you can use file redirection to input the IP addresses to the transfer.exe utility. To do this, create a text file
containing a carriage-return delimited list of IP addresses or DNS names for the instruments to be updated. If you created a
text file named HOSTS.TXT, you would enter the following command to update a group of instruments:

transfer.exe < HOSTS.TXT

NOTE. You can also place the instrument into the upgrade mode by pressing and holding the CAPTURE button during
power up until the button light goes out.

Verifying the Upgrade
After you have completed the software upgrade, the instrument will reboot and come up in an operational mode.

To verify the functional performance of your instrument, perform the Incoming Inspection procedures.

NOTE. See the Readme.txt file that is included with the software-upgrade package to determine whether all of the current
Configuration menu and instrument-mode settings were preserved through upgrading.

46 Waveform Monitors Technical Reference



Supplemental Operating Information

Description of Cable Types
The Cable Type selection in the CONFIG > Physical Layer Settings menu enables you to specify the type of cable that
most closely matches the cable used to connect the signal source to the instrument. The following is a list of supported
cable type descriptions:

Belden 8281. Coax-Double Braided RG-59/U Type Number of Coax: 1 RG Type: 59/U AWG: 20 Stranding:
Solid Conductor Material: BC- Bare Copper Insulation Material: PE-Polyethylene Outer Shield Material: TC-Tinned
Copper/TC-Tinned Copper Outer Jacket Material: PE-Polyethylene Plenum (Y/N): N Plenum Number: 88281 Nom.
Characteristic Impedance: 75 ohm Applications: Precision Video Cable for Analog and Digital, Double Braided RG-59/U
Type, Broadband Coax, Headend/Video Cables, Precision Video Cable for Analog and Digital, RG-59/U Type

Belden 1694A. Coax-Low Loss Serial Digital Coax Number of Coax: 1 RG Type: 6/U AWG: 18 Stranding: Solid
Conductor Material: BC-Bare Copper Insulation Material: Gas-injected FHDPE-Foam High Density Polyethylene Outer
Shield Material Trade Name: Duofoil: Outer Shield Material: Aluminum Foil-Polyester Tape-Aluminum Foil/TC-Tinned
Copper Outer Jacket Material: PVC-Polyvinyl Chloride Plenum (Y/N): N Plenum Number: 1695A Nom. Characteristic
Impedance: 75 ohm Applications: Precision Video Cable for Analog and Digital, Low Loss Serial Digital Coax, Video
Cable, Precision Video Cables for Analog and Digital Applications, Precision Video Cable for Analog and Digital,
RG-6/U Type

Belden 1505. Coax-RG-59/U Type Number of Coax: 1 RG Type: 59/U AWG: 20 Stranding: Solid Conductor Material:
BC-Bare Copper Insulation Material: Gas-injected FHDPE-Foam High Density Polyethylene Outer Shield Material Trade
Name: Duofoil: Outer Shield Material: Aluminum Foil-Polyester Tape-Aluminum Foil/TC-Tinned Copper Outer Jacket
Material: PVC-Polyvinyl Chloride Plenum (Y/N): N Plenum Number: 1506A Nom. Characteristic Impedance: 75 ohm
Applications: Broadband Coax, Headend/Video Cables, Video Cable, Precision Video Cables for Analog and Digital
Applications, Precision Video Cable for Analog and Digital, RG-59/U Type

Belden 1855A. Coax-Sub-Miniature Number of Coax: 1 RG Type: Sub-miniature 59/U AWG: 23 Stranding: Solid
Conductor Material: BC-Bare Copper Insulation Material: Gas-injected FHDPE-Foam High Density Polyethylene Outer
Shield Material Trade Name: Duofoil: Outer Shield Material: Aluminum Foil-Polyester Tape-Aluminum Foil/TC-Tinned
Copper Outer Jacket Material: PVC-Polyvinyl Chloride Plenum (Y/N): N Nom. Characteristic Impedance: 75 ohm
Applications: Video Cable, Precision Video Cables for Analog and Digital Applications, Precision Video Cable for Analog
and Digital, Sub-Miniature, Precision Video Cable for Analog and Digital, Sub-Miniature RG-59/U Type

Canare L-5CFB. Coax-Solid Copper Center Conductor; Foam PE Dielectric Tinned Copper Braid + 100% Foil Shield
Dielectric; 100% Sweep Tested; Nominal O.D. in. (mm): .303 (7.7); PVC Jacket Thickness in. (mm): .043 (1.1)

Image 1000. Coax-Conductor size: nominal mm 1.0; Conductor material: Copper, Plain; Dielectric material: Cellular
PE; Inner Screen: Aluminium Polyester Tape; Outer Screen: Tinned Copper Braid 95%; Jacket Material: LSOH (PVC
to special order); Nominal Diameter: mm 6.8; Cable weight: kg/km 60.0; Impedance ohms (+/-1): 75.0 Capacitance
(nominal): p/F/m 56.0 DC resistance max ohms/100m: 2.19 Velocity of propagation %: 83.0
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